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Úvod
Vážený klient,

integrácia firemných systémov s bankovými systémami je stále častejšia téma nielen pre najväčšie firmy s desiatkami tisíc platieb 
ročne, ale aj pre malé firmy, ktoré podnikajú napríklad v oblasti online predaja tovaru a služieb.

Sme radi, že ste si pre svoje riešenie vybrali práve náš produkt BusinessNet Connect. Príručka, ktorá sa Vám dostáva do rúk, Vám 
pomôže so správnym nastavením prepojenia systémov.

V prípade otázok sa neváhajte obrátiť na našu technickú podporu.

Kontaktný email: eb@unicreditgroup.sk.

Telefónne číslo: +421 2 6920 2097 (pracovné dni 8.00 – 16.30).

UniCredit Bank Czech Republic and Slovakia, a.s., pobočka zahraničnej banky
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ZÁKLADNÉ POJMY
BusinessNet Connect  
BusinessNet Connect je služba banky slúžiaca na výmenu súborov medzi klientom a bankou pomocou protokolu WebDAV. 
Umožňuje sťahovanie výpisov a upload platobných inštrukcií. Komunikácia prebieha zabezpečene pomocou certifikátov a umožňuje 
automatizáciu, pozri kapitola 5.

WebDAV 
Technológia použitá pre službu BusinessNet Connect. Ide o štandardizované rozšírenie https protokolu, ktorý umožňuje vzdialenú 
správu súborov na webovom serveri. Výhodou je natívna podpora protokolu v operačných systémoch.

Technický užívateľ 
Profil užívateľa, určený iba na prácu s produktom BusinessNet Connect. Užívateľ nie je určený na bežnú prácu v internetovom 
bankovníctve BusinessNet Professional.

Heslo pre telefonickú komunikáciu 
Heslo slúžiace na sekundárnu identifikáciu klienta počas komunikácie s technickou podporou elektronického bankovníctva. 
Je nevyhnutné pre odblokovanie zablokovaného užívateľa. Úpravy a nastavenia tohto hesla zaisťuje bankový poradca.
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1.	 SKÔR NEŽ ZAČNETE

1.1	 Koncept prístupových práv
K WebDAV zložke by mal mať prístup iba automatizovaný proces alebo jedna osoba, ktorá bude sťahovať/nahrávať súbory z/na lokálnu 
zložku. Prístup k lokálnym súborom by mal byť riadený na úrovni firemných oprávnení – napríklad pomocou Active Directory / LDAP, ktoré 
spravuje administrátor firmy na základe interných procesov firmy. Hneď ako je súbor raz uložený lokálne, Banka nemá prostriedky, ako 
pomôcť s kontrolou prístupových práv. Dobre si teda rozmyslite, kto má mať prístup k týmto lokálnym súborom (napr. k výpisom, ktoré 
obsahujú údaje o mzdách, alebo iné citlivé dáta).

Priamy prístup k WebDAV zložke by nemal byť nikdy zdieľaný!
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1.2	 Úroveň automatizácie
Úroveň automatizácie je najčastejšie daná internými procesmi firmy. BusinessNet Connect ponúka možnosť, ako tieto procesy plne 
automatizovať. V takom prípade by mal byť na nahrávanie a sťahovanie, šifrovanie, dešifrovanie a podpis súborov použitý príkazový riadok 
spoločne s automatickým spúšťaním úloh. Skôr než začnete s integráciou, zamyslite sa nad tým, ktoré procesy by mali byť automatizované.

BusinessNet Connect je napríklad vhodné použiť na sťahovanie výpisov MT942/camt.052 (s pohybmi počas dňa), ktoré sú potom 
nahrávané do účtovného systému. Pre import platobného súboru s faktúrami, ktorý je vykonávaný raz mesačne, plne dostačuje 
klasický BusinessNet Professional (ručný import užívateľom pomocou internetového prehliadača).

Zvážte nasledujúce aspekty:

•	 Je potrebné robiť úkon veľmi často (napr. výpis s pohybmi je potrebné sťahovať každých 5 minút)? Potom použite BusinessNet Connect.
•	 Je pre úkon rozhodujúca včasná reakcia (napr. platby je nutné odoslať do 5 minút po vygenerovaní faktúry v účtovnom systéme)? 

Potom použite BusinessNet Connect.
•	 Zakazuje interný proces firmy, aby sa súboru dotkla ľudská ruka (napr. musí byť doručený priamo z účtovného systému do Banky)? 

Potom použite BusinessNet Connect.

Ale:

•	 Potrebujete autorizovať platby viacerými osobami a účtovný systém firmy nepodporuje viacúrovňové podpisové oprávnenia? Potom 
pre samotný podpis transakcií použite BusinessNet Professional.

1.3	 Ošetrenie neštandardných situácií
Počas návrhu integrácie odporúčame nastavenie interných procesov firmy pre prípady, kedy sa nemožno k WebDAV zložke pripojiť 
(napríklad kvôli plánovanému výpadku internetového bankovníctva).

V rámci týchto opatrení odporúčame nastaviť:

•	 monitoring dostupnosti služby,
•	 automatické zasielanie varovaní o nedostupnosti služby – napríklad emailom na IT správcu systému,
•	 proces (manuálne alebo automatizovaný) pre opätovné pripojenie WebDAV zložky,

1.4	 Certifikáty

Na zvýšenie bezpečnosti pripojenia k službe BusinessNet Connect môžete voliteľne použiť certifikát, ktorým banka overí vaše 
prihlasovacie údaje.  
Ak chcete certifikát na overenie prihlasovacích údajov používať, informujte svojho bankového poradcu.

Podporované certifikáty a certifikačné autority

Pokiaľ už certifikát využívate a chceli by ste iba rozšíriť jeho využitie pre UniCredit bank, je potrebné, aby bol nami podporovaný. Pre BusinessNet 
Connect akceptujeme nasledujúce certifikačné autority:

•	 Actalis (https://www.actalis.com),
•	 1. certifikační (https://www.ica.cz/),
•	 Česká pošta, s.p. (https://www.postsignum.cz),
•	 EIdentity (https://www.eidentity.cz).

Pokiaľ s podobnými certifikátmi doposiaľ nepracujete, odporúčame vám využiť certifikát typu S/MIME od certifikačnej autority Actalis 
(Taliansko), ktorá poskytuje certifikáty s exspiráciou 1 rok s možnosťou následného predĺženia. Na účely certifikácie pri spojení s WEBDAV 
zložkou je tento certifikát plne vyhovujúci. Návod na jeho stiahnutie a inštaláciu nájdete nižšie.

https://www.actalis.com
https://www.ica.cz/
https://www.postsignum.cz
https://www.eidentity.cz
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Exspirácia certifikátov

Certifikáty majú obmedzenú platnosť – 1 rok. Exspirovaný certifikát nie je možné použiť na zabezpečené prihlásenie.  
Kontrolu platnosti certifikátu a včasnú obnovu zaisťuje klient.

Držiteľ certifikátu 

Pokiaľ doteraz nevyužívate žiadny elektronický certifikát, odporúčame vám, aby ste sa pred jeho zadovážením zamysleli, kto bude oprávnený 
takýto certifikát spravovať a distribuovať ho ďalej na bankovú stranu. Odporúčame vám, aby táto osoba zodpovedná za distribúciu verejnej 
časti certifikátu smerom k bankovej strane bola osoba, ktorá je už teraz poverená správou BusinessNet Connect. Táto osoba je oprávnená 
meniť a držať heslá pre BusinessNet Connect a je uvedená v kontaktnom emaile pre správu technického užívateľa.

Zdieľanie verejnej časti certifikátu s bankou

Verejné časti certifikátov nám, prosím, zasielajte na mailovú adresu našej technickej podpory eb@unicreditgroup.sk. Následne od nás 
dostanete informáciu o prijatí vášho certifikátu bankou. Hneď ako dostanete potvrdenie o prijatí certifikátu, zabezpečenie spojenia so 
zložkou WebDAV je nastavené a môžete ho plne využívať.

Vzorový príklad stiahnutia a inštalácie certifikátu typu S/MIME od certifikačnej autority ACTALIS 

a)	Získanie certifikátu
Tento certifikát môžete získať zadarmo na jeden rok z webových stránok Actalis tu:  
https://www.actalis.com/s-mime-certificates

•	 Je nutné použiť platný email na získanie overovacieho kódu.
•	 Overovací kód ďalej použite na dokončenie generovania certifikátu.
•	 Výsledkom bude zobrazené heslo (napr. jy5b36w3xZ8a) a email s priloženým KPCS12 – S/MIME certifikátom chráneným heslom.

 
b)	Inštalácia certifikátu / Extrakcia verejnej časti certifikátu 
1)	 Certifikát nainštalujte do Windows.

•	 Potvrďte inštaláciu a na opýtanie vložte heslo.
2)	 Vyexportujete verejnú časť certifikátu (verejný kľúč).

•	 Spustite Internet Explorer.
•	 Zvoľte menu: Tools -> Internet Options -> Content -> Certificates.
•	 Vyberte konkrétny certifikát a zvoľte „Export“.
•	 Zvoľte možnosť: „No, do not export private key“.
•	 Vyberte formát: „Der encoded Binary X.509.

3)	 Výsledkom je verejný certifikát (kľúč), Certificate File: xxx.cer
c)	Zaslanie verejnej časti certifikátu banke 

•	 Verejný kľúč, prosím, zašlite banke na adresu eb@unicreditgroup.sk.

•	 Naša technická podpora vám spätne potvrdí prijatie certifikátu bankou UniCredit.

mailto:eb%40unicreditgroup.sk?subject=
https://www.actalis.com/s-mime-certificates
mailto:eb%40unicreditgroup.sk?subject=
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2.	 NASTAVENIE SPOJENIA DO UNICREDIT BANK

2.1	 WebDAV agent
Na spojenie s bankou odporúčame používať WebDAV agenta, ktorý umožňuje ukladať informácie o predchádzajúcich spojeniach (sessions), 
a to najmä vtedy, ak bude spojenie s bankou prebiehať počas dňa opakovane. Komunikácia s bankou a prenos dát sú potom rýchlejšie. 
Vhodnými WebDAV agentmi sú napríklad (nejde o úplný zoznam): 
•	 Syncovery,

•	 Súborový manažér Total Commander,
•	 Sardine Java WebDAV klient.

Poznámka: Aplikácia WinSCP ukladanie informácií o predchádzajúcich spojeniach nepodporuje a pre časté spojenie s bankou ju preto 
nemožno odporučiť.

2.2	 Nastavenie technického užívateľa
Osobe zodpovednej za technického užívateľa je doručené užívateľské meno a jednorazový „Bezpečnostný kód“ (heslo) k technickému 
užívateľovi v emaile. Jednorazový Bezpečnostný kód je platný 2 dni, dovtedy je potrebné ho zmeniť:
•	 do svojho prehliadača zadajte adresu https://www.unicreditbank.sk,
•	 zvoľte prihlásenie do BusinessNet pre firemné účty,
•	 do poľa „ID užívateľa“ prihlasovacej obrazovky zadajte užívateľské ID technického užívateľa,
•	 do poľa „Bezpečnostný kód“ zadajte kód (svoje nové heslo), ktorý bol uvedený v emaile (min. 6 znakov),
•	 stlačte tlačidlo „Prihlásiť“,
•	 v ďalšom kroku budete vyzvaní na zadanie starého „Bezpečnostného kódu / Hesla“ a zvolenie nového „Bezpečnostného kódu / Hesla“,
•	 po nastavení sa z internetového bankovníctva odhláste.

2.3	 �Nastavenie WebDAV-u bez certifikátu pre overenie prihlasovacích údajov
S WebDAV zložkou je možné pracovať niekoľkými spôsobmi. Môžete k nej pristupovať:
•	 ako k sieťovému disku

	- kopírovať súbor je možné potom jednoducho pretiahnutím myšou,
	- alebo je možné použiť príkazový riadok (tento spôsob umožňuje plnú automatizáciu procesov),

•	 pomocou súborového manažéra – napríklad Total Commanderu. 

Nižšie nájdete popis niekoľkých spôsobov, ako sa k WebDAV zložke pripojiť. Zoznam spôsobov však nie je – BusinessNet Connect bol 
napríklad pre Linux úspešne otestovaný s davfs alebo Cadaver klientom.

Cieľový bod (Endpoint) na pripojenie bez certifikátu na overenie prihlasovacích údajov je https://sk.unicreditbanking.net/webdav/. 

Windows – nastavenie natívneho WebDAV klienta 

Pre nastavenie:
•	 v príkazovom riadku zadajte príkaz (X: označuje písmeno disku, pod ktorý bude WebDAV namapovaný): 

net use X: https://sk.unicreditbanking.net/webdav/
•	 zadajte užívateľské meno (ID) technického užívateľa,
•	 zadajte heslo (Bezpečnostný kód) pre technického užívateľa.

Total Commander – súborový manažér pre Windows 

Pre používanie WebDAV-u spolu s Total Commanderom budete potrebovať nainštalovať doplnok (plugin). 
•	 nainštalujete Total Commander – na stiahnutie na adrese:  

http://www.ghisler.com 
•	 nainštalujte WebDAV plugin – na stiahnutie na adrese:  

http://www.ghisler.com/dplugins.htm 

https://www.syncovery.com/
http://www.ghisler.com
https://github.com/lookfirst/sardine
https://www.unicreditbank.sk
https://sk.unicreditbanking.net/webdav/
http://www.ghisler.com
http://www.ghisler.com/dplugins.htm
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Pre nastavenia spojenia: 
•	 medzi diskami vyberte Miesta v sieti, vyberte zložku WebDAV a stlačte F7 na vytvorenie novej zložky (spojenie). 
•	 zadajte názov nového priečinka,
•	 do poľa Connect to zadajte:  

https://sk.unicreditbanking.net/webdav/
•	 do poľa „User name“ zadajte užívateľské meno (ID) technického užívateľa,
•	 do poľa „Password“ zadajte heslo pre technického užívateľa,
•	 zaškrtnite voľbu „Secure server (via SSL)“,
•	 odškrtnite voľbu „Use multi-step upload method“,
•	 ostatné polia zostanú nezaškrtnuté.

Linux – nastavenie natívneho WebDAV klienta 

Napríklad v Ubuntu je možné nastaviť nasledovne: 
•	 v menu vyberte položku „File“, ďalej „Connect to Server“ a „Secure WebDAV (HTTPS)“,
•	 do poľa „Server“ zadajte:  

https://sk.unicreditbanking.net/webdav/ 
•	 do poĽa „Folder“ zadajte „/webdav/”,
•	 do poľa „User name“ zadajte užívateľské meno (ID) technického užívateľa,
•	 do poľa „Password“ zadajte heslo pre technického užívateľa.

2.4	 �Nastavenie WebDAV-u s certifikátom pre overenie prihlasovacích 
údajov

Pred prvým spojením s bankou je potrebné do banky doručiť verejný kľúč certifikátu (pozri kapitola 1.4), ktorým sa overujú prihlasovacie 
údaje. Kľúč sa nastavuje pre technického používateľa a osoba zodpovedná za technického používateľa musí verejný kľúč zaslať banke 
emailom na adresu eb@unicreditgroup.sk.

V predmete správy uveďte „Nastavenie verejného kľúča pre overenie technického užívateľa“ a doplňte užívateľské meno (ID) 
technického užívateľa.

Do tela emailu uveďte meno firmy.

Tento email bude akceptovaný iba v prípade, ak bude odoslaný z e-mailovej adresy, ktorá je pre používateľa uvedená v sekcii Zoznam 
držiteľov kľúča zmluvnej dokumentácie k BusinessNet Connect.

Po nastavení kľúča k technickému užívateľovi banka emailom potvrdí, že verejný kľúč bol nastavený.

Cieľový bod (Endpoint) pre pripojenie s certifikátom na overenie prihlasovacích údajov je https://connect.unicreditbanking.net/sk/. 

V ostatných parametroch sa nastavenie WebDAV-u nelíši oproti variantu bez certifikátu na overenie prihlasovacích údajov.

https://sk.unicreditbanking.net/webdav/
https://sk.unicreditbanking.net/webdav/
mailto:eb%40unicreditgroup.sk?subject=
https://connect.unicreditbanking.net/sk/
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3.	 SŤAHOVANIE DÁT

3.1	 Elektronické výpisy
Pomocou BusinessNet Connectu je možné sťahovať nasledujúce typy elektronických výpisov:

•	 Denné výpisy / MT940 – ABO, Clearing, Csv, Gemini, MultiCash neštrukturovaný, MultiCash štruktúrovaný
•	 Denné výpisy / camt.053 v.2 – XML
•	 Denné výpisy / camt.053 v.8 – XML
•	 Výpis s pohybmi počas dňa / MT942 – MultiCash neštrukturovaný, MultiCash štruktúrovaný
•	 Výpis s pohybmi počas dňa / camt.052 v.2 – XML
•	 Výpis s pohybmi počas dňa / camt.052 v.8 – XML

S pripojenou WebDAV zložkou je možné pracovať ako s akoukoľvek inou zložkou. Aby bolo umožnené sťahovanie súborov automatizovať, 
je hierarchia adresárov a konvencia pomenovania súborov vopred daná.

3.1.1	 Adresárová štruktúra

V zložke „statements“ je pod adresárom s (technickým) číslom klienta:

•	 10 adresárov, ktoré obsahujú denné výpisy MT940/camt.053 (pomenované podľa dátumu), 
•	 jeden adresár – „intraday“, ktorý obsahuje výpis MT942/camt.052 s pohybmi počas dňa.

Každý adresár je ďalej členený do podadresárov podľa typu formátu výpisu a v nich sú už dostupné jednotlivé výpisy ako súbory. Výpisy 
sú zároveň generované vo všetkých typoch formátov, pokiaľ teda potrebujete napríklad denný výpis vo formáte Gemini pre jeden 
účtovný systém a MT940 MultiCash štruktúrovaný pre iný účtovný systém, stačí stiahnuť súbor zo správneho adresára.

Zoznam účtov dostupných pre BusinessNet Connect sa riadi právami nastavenými pre technického užívateľa na základe zmluvnej dokumentácie.

Pre tieto zložky má technický užívateľ iba právo čítania.

Poznámka: Denné výpisy (MT940/camt.053) staršie ako 10 kalendárnych dní sú naďalej dostupné pre manuálne stiahnutie 
v BusinessNetu – menu Financie > Účty > Elektronické výpisy.
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3.1.2	 Menná konvencia pre súbory s elektronickými výpismi

Názov súboru vždy obsahuje číslo účtu, nasledovaný pomlčkou a menou účtu.

V prípade denného výpisu MT940 je tak pre štruktúrovaný, ako aj pre neštruktúrovaný formát MultiCash, prípona súboru „.sta“ a pre 
formát Gemini je prípona „.ace“ atď.

Pre výpis s pohybmi počas dňa MT942 je tak pre štruktúrovaný, ako aj pre neštruktúrovaný formát MultiCash, prípona súboru „.vml“.

Príklad: Súbor s výpisom MT940 pre EUR účet 7958086 vedený v UniCredit Bank bude mať názov: UNCRSKBX_7958086-EUR.sta

V prípade, že je pre BusinessNet Connect nastavené, aby sťahované výpisy šifroval, potom je ešte pre všetky typy a formáty výpisov 
pridaná ďalšia prípona „.esc“.

3.1.3	 Formát a stránkovanie výpisov

Aktuálny popis pre formáty denných výpisov (MT940/camt.053) a výpisov s pohybmi počas dňa (MT942/camt.052) je dostupný na webu banky:

Výpis MT942/camt.052 sťahovaný cez BusinessNet Connect obsahuje všetky MT942/camt.052 správy, ktoré boli v daný deň už 
vygenerované. Najnovšia správa je vždy pripojená na koniec výpisu. Pri spracovaní takéhoto výpisu je teda potrebné zohľadniť, ktoré 
transakcie už boli obsiahnuté v predošlých správach a boli teda spracované.

Jednotlivé správy je možné odlíšiť podľa čísla a strany výpisu a času generovania výpisu.

Pri práci s výpismi je potrebné zohľadniť, že používajú stránkovanie (podobne ako papierové výpisy). V závislosti od objemu informácií v 
jednotlivých transakciách je výpis stránkovaný po 6 – 7 transakciách. Stránkovanie je používané tak pre výpisy MT940/camt.053, ako aj pre 
výpisy MT942/camt.052.

3.2	 Zostatky
Pomocou BusinessNet Connectu je možné sťahovať špeciálny CSV súbor, ktorý obsahuje informácie o zostatkoch na účtoch. Ide 
o rovnaké informácie, aké sú dostupné v BusinessNet Professional „Prehľad zostatkov“ (menu Financie > Účty).

Obsahuje tak informáciu o zostatku z posledného výpisu, ako aj aktuálny účtovný a disponibilný zostatok. Aktuálne zostatky sú platné 
k okamihu prihlásenia technického užívateľa do BusinessNet Connect.

Príklad CSV súboru:

Význam stĺpcov v CSV súbore je nasledujúci:

•	 Number – číslo účtu
•	 Type – typ účtu
•	 Curr – mena účtu
•	 Title – podrobnejší popis typu účtu, je skracované na 20 znakov
•	 Name – vlastné pomenovanie účtu
•	 Last Statement – účtovný zostatok z posledného výpisu
•	 Date – dátum posledného výpisu
•	 Actual Balance – aktuálny účtovný zostatok
•	 Available Funds – aktuálny disponibilný zostatok
Poznámka: Adresár neobsahuje žiadnu históriu súborov so zostatkami, iba aktuálny súbor pre každý z účtov. Na zachovanie kompletnej 
histórie zostatkov je potrebné pravidelne súbory sťahovať.

S pripojenou WebDAV zložkou je možné pracovať ako s akoukoľvek inou zložkou. Aby bolo umožnené sťahovanie súborov 
automatizovať, je hierarchia adresárov a konvencia pomenovania súborov vopred daná.

https://www.unicreditbank.sk/content/dam/cee2020-pws-sk/sk-dokumenty/dokumenty-k-produktom/velke-firmy/cash-management/BNP_export_formaty_SK.zip
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3.2.1	 Adresárová štruktúra

V zložke balances je pod adresárom s (technickým) číslom klienta pre každý pripojený účet samostatný súbor so zostatkami.

Pre túto zložku má technický užívateľ iba právo čítania.

3.2.2	 Menná konvencia pre súbory so zostatkami

Názov súboru vždy obsahuje číslo účtu a dátum generovania súboru.

Príklad: Súbor s údajmi o zostatkoch pre účet 7958086 generovaný dňa 24. 3. 2026 bude mať názov 795808620260324.csv. 
V prípade, že je pre BusinessNet Connect nastavené, aby sťahované súbory so zostatkami šifroval, potom je ešte pre všetky súbory 
pridaná ďalšia prípona „.esc“.

4.	 NAHRÁVANIE SÚBOROV – UPLOAD
BusinessNet Connect podporuje nasledujúce formáty platobných súborov:
•	 zahraničné platby – CSV, Gemini, MultiCash,
•	 SEPA platby – pain.001 a pain.008.

Aktuálny popis formátov pre platobné súbory nájdete na webe banky.

Práca s WebDAV zložkou je rovnaká ako práca s ktoroukoľvek sieťovou zložkou. Aby bolo možné nahrávanie súborov automatizovať, 
je definovaná nasledujúca adresárová štruktúra a menná konvencia.

4.1	 Adresárová štruktúra

https://www.unicreditbank.sk/sk/velke-firmy/cash-management/elektronicke-bankovnictvo.html
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V zložke upload sú 3 zložky:

•	 foreign,
•	 sepa,
•	 status.

Foreing / SEPA sa ďalej delí na podzložky podľa formátu platobného súboru a ďalej potom podľa kódovania súboru. Platobný súbor 
je jednoducho skopírovaný do správnej zložky – čo je rovnaké, ako by ste použili funkčnosť upload v BusinessNet Professional.

Výsledok nahrania súboru je možné skontrolovať v zložke status (pozri ďalej).

Zoznam účtov, ktoré môžu byť použité v platobnom súbore, sa riadi zoznamom účtov, ktoré má priradené v rámci zmluvnej 
dokumentácie technický užívateľ s právami súbory nahrávať.

Každý nahrávaný súbor musí mať unikátne meno. Odporúčame používať dátum a čas ako súčasť názvu súboru. Maximálna dĺžka mena 
súboru je 64 znakov vrátane prípony.

Technický užívateľ má do adresárov iba právo zapisovať. Z dôvodu bezpečnosti nemožno nahrané súbory z WebDAV zložky čítať.

4.2	 Ošetrenie chýb pomocou statusového súboru
Pre každý nahraný súbor je v zložke status vytvorený statusový súbor. Súbor obsahuje informáciu o výsledku nahrania a ďalej súhrnné 
dáta o platobnom balíčku (súhrn je podobný ako na detaile balíčka v BusinessNet Professional).

Názov súboru sa vždy začína dátumom a časom nahrania a potom nasleduje meno nahrávaného súboru. Prípona je txt.

Príklad: Platobný súbor pomenovaný „SEPA_7958211_24032026_001.xml“, ktorý bol nahratý 24. 3. 2026 13:31:23_379, bude mať 
statusový súbor s nasledujúcim pomenovaním: 2026-03-24_13-31-23_379. SEPA_7958211_24032026_001.xml.txt.

Po nahraní súboru je potrebné skontrolovať nasledujúce pole statusového súboru:

•	 Status – status nahraného súboru:
	• Ak súbor skončí v statuse „306 (Error)“, takýto balíček nie je možné nahrať a nebude ani zobrazený v Prehľade súborov 

v BusinessNet Professional. Pred znovunahraním súboru je potrebné ho opraviť. Jednotlivé chybové kódy sú popísané nižšie.
	• Úspešne nahraný balíček, ktorý je pripravený na podpis, bude v statuse „302 (To sign)“.
	• Čiastočne podpísaný balíček (predpokladom je nastavenie automatického spracovania príkazov) bude v statuse „303 (P. signed)“. 

Takýto balíček musí byť dopodpísaný v BusinessNet Professional.
	• Pokiaľ je balíček finálne podpísaný (predpokladom je nastavenie automatického spracovania príkazov), potom bude status prázdny.

Poznámka: V prípade automatického spracovania príkazov môže proces podpísania trvať až 5 minút. Statusový súbor je potom 
aktualizovaný. Výsledok podpisu je teda potrebné prípadne skontrolovať neskôr.

Ďalej odporúčame kontrolovať tieto polia:

•	 # Orders – počet príkazov v platobnom súbore.
•	 Checksum – suma všetkých čiastok všetkých platieb (bez rozlíšenia meny a smeru platby – teda suma absolútnych hodnôt).
•	 # To sign – je rovné nule, pokiaľ boli všetky príkazy automaticky podpísané (predpokladom je nastavenie automatického 

spracovania príkazov). Nenulová hodnota znamená, že balík obsahuje príkazy, ktoré je nutné podpísať v BusinessNet Professional.
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Nasledujúca tabuľka by vám mala pomôcť zistiť príčinu, prečo nebol balíček úspešne nahraný:

Pole Status Príčina
Problémy s právami technického užívateľa k účtom
Status : 306 (Error)

     IBX00016 (USER HAS NOT IMPORT/UPLOAD RIGHTS FOR 
THE ACCOUNT Code[IBX00016])

Technický používateľ nemá právo uploadovať aspoň pre jeden 
z účtov, ktorý bol použitý v platobnom súbore.

Status : 306 (Error)

     IBX00188 (Current account not existing Code[I-
BX00188])

Aspoň jeden účet použitý v platobnom súbore nie je priradený 
technickému užívateľovi.

Problémy s formátom platobného súboru
Status : 306 (Error)

     IKC00022 (Parsing Impossible Code[IKC00022])

Obsah súboru nie je možné rozkľúčovať.

Tento typ chyby môže nastať napríklad v týchto situáciách:
•	 Správne štruktúrovaný súbor bol nahraný do zlej podzložky 

(napr. SEPA súbor do Gemini podzložky pre zahraničné platby).
•	 Nahrávaný súbor má zlý formát (napr. je súbor poškodený).

Problémy so šifrovaním a podpisom
Status : 306 (Error)

     JWB0524 (Uploaded file was not plain but the chosen 
transport profile accepts only plain files. (JWB0524))

Problém s dešifrovaním súboru na strane Banky.
Tento typ chyby môže nastať napríklad v týchto situáciách:
•	 Nahrávaný súbor bol šifrovaný alebo podpísaný, BusinessNet 

Connect je však nastavený tak, že prijíma iba súbory 
v otvorenej forme.

•	 Nahrávaný súbor bol v otvorenej (nešifrovanej) forme, 
BusinessNet Connect je však nastavený tak, že prijíma iba 
šifrované súbory.

•	 Nahrávaný súbor nebol podpísaný, BusinessNet Connect je 
však nastavený tak, že prijíma iba podpísané súbory.

•	 Nahrávaný súbor nebol ani šifrovaný ani podpísaný, 
BusinessNet Connect je však nastavený tak, že prijíma iba 
podpísané šifrované a zároveň podpísané súbory.

Status : 306 (Error)

     SG74107 (General public key error. (SG74107))

Problém s typom používateľského podpisového kľúča, ktorý bol 
použitý na podpis súboru.

Verejný kľúč, ktorý je priradený v Banke u užívateľa, musí byť 
nahradený správnym typom (kľúč musí byť pre užívateľa znovu 
vygenerovaný a znovu registrovaný v Banke).

Status : 306 (Error)

     SG74106 (General private key error. (SG74106))

Problém s verejným kľúčom Banky, ktorý bol použitý na 
šifrovanie nahrávaného súboru.

Zo stránok Banky je potrebné stiahnuť nový kľúč a nastaviť 
ho v pgp programe.
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4.2.1	 Príklad statusového súboru pre úspešné nahranie

Statusový súbor po úspešnom nahraní cez BusinessNet Connect (balíček obsahuje 2 príkazy a je pripravený na podpis v BusinessNet 
Professional):

Status : 302 (To sign)
Pay.Type : 3 (Sepa Payment)
Changed : false
Filename : SEPA_7958211_24032026_001.xml
Type : 1 (Upload)
Structure : 7 (SEPA Pain001 (XML))
Timestamp : 24.03.2026 13:31:23
Checksum : 1.02
Digest : BCA91A0381A0E9ADE29ECAFE22D7F837
Errors : 0
# To sign : 1
# Orders : 1

BNC7958|Technical User EST - BANKING CORP|Upload|24/03/2026 13:31:23|

4.2.2	 Príklad statusového súboru pre neúspešné nahranie

Statusový súbor pre neúspešné nahranie cez BusinessNet Connect (v platobnom súbore bol použitý účet, pre ktorý nemá technický 
užívateľ právo nahrávať):

Status : 306 (Error)
     IBX00016 (USER HAS NOT IMPORT/UPLOAD RIGHTS FOR THE ACCOUNT Code[IBX00016])
Pay.Type : 1 (Foreign Payment)
Changed : false
Filename : 20260326_invoices_II.ska
Type : 1 (Upload)
Structure : 1 (MultiCash format)
Timestamp : 22.3.2026 10:01:24
Checksum : 0.00
Digest : 2d8837df68f388a8e24065ed90d62552
Errors : 0
# To sign : 0
# Orders : 0

25029752| CA Europa Test|Reservation|22/3/2026 10:01:24|
25029752||File imported|22/3/2026 10:02:12|

5.	 ŠIFROVANIE
BusinessNet Connect umožňuje šifrovanie sťahovaných aj nahrávaných súborov. Ide o ďalší bezpečnostný prvok, ktorý je možné 
voliteľne nastaviť.

BusinessNet Connect podporuje iba OpenPGP kľúče typu RSA s platnosťou do 1 roka.

Pre prácu s kľúčmi a samotné šifrovanie či dešifrovanie uvádzame ako príklad program Gpg4win a jeho grafickú nadstavbu Kleopatra. 
Aplikácia je voľne dostupná na stiahnutie zadarmo napr. tu: https://www.gpg4win.org. 

https://www.gpg4win.org
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5.1	 Základné pojmy
Pár kľúčov klienta (vytvoríme v aplikácii Kleopatra)

•	 Verejný kľúč  
Banka verejný kľúč klienta používa na šifrovanie obsahu súborov (výpisov). Šifrovaný súbor je možné dešifrovať súkromným kľúčom klienta. 

•	 Súkromný kľúč  
Kľúč slúži na dešifrovanie obsahu súborov, ktoré boli zašifrované pomocou verejného kľúča. 

Verejný kľúč banky (banka poskytuje klientovi) 
Verejný kľúč banky slúži na zašifrovanie súboru platieb na strane klienta a je poskytovaný bankou na vyžiadanie.

Podpisový používateľ (nižšie v kapitole 5.2 uvádzame príklad vytvorenia PGP) 
Užívateľ určený iba na podpis súborov platieb na strane klienta. Podpisových užívateľov môže byť aj viac. Užívateľ nie je určený 
na bežnú prácu v BusinessNet Professional. Súkromná časť kľúča tohto používateľa sa používa na strane klienta na podpísanie súborov 
platieb zasielaných do banky. Verejná časť kľúča sa používa na strane banky na overenie podpisu súboru platieb zaslaným klientom 
do banky pri automatickom spracovaní príkazov.

5.2	 Príklad vytvorenia nového páru kľúčov v aplikácii Kleopatra
Pre vygenerovanie páru verejný/súkromný kľúč:

•	 Vyberte z menu Súbor -> Nový pár kĽúčov. 
•	 Zvoľte možnosť Vytvoriť osobný pár kľúčov OpenPGP a vyplňte voliteľné údaje (slúžia ako identifikátory certifikátu):

	• meno (môže byť aj názov spoločnosti),
	• email. 

•	 Zvoľte možnosť Pokročilé nastavenia a vyplňte:
	• typ kĽúčov: RSA,
	• použitie certifikátu: podpisovanie, platný do – jeden rok.

Po vytvorení páru kľúčov môžete zvoliť rovno možnosť exportovať jeho verejnú časť a uloženie verejného kľúča do súboru. 

•	 Zvoľte Send Public Key By Email.
•	 Poprípade pravým tlačidlom v zozname certifikátov zvoľte možnosť: Exportovať.

5.3	 Proces doručenia verejnej časti klientskeho kľúča banke
Kľúč sa nastavuje pre technického používateľa a osoba zodpovedná za technického používateľa musí verejný kľúč zaslať banke 
emailom na adresu eb@unicreditgroup.sk. 

V predmete správy uveďte „Nastavenie verejného kľúča pre technického užívateľa“ a doplňte užívateľské meno technického užívateľa.  
Do tela emailu uveďte meno firmy.

Tento email bude akceptovaný iba v prípade, ak bude odoslaný z emailovej adresy, ktorá je pre užívateľa uvedená v sekcii Zoznam 
držiteľov kľúča zmluvnej dokumentácie k BusinessNet Connectu.

Po nastavení kľúča k technickému užívateľovi banka emailom potvrdí, že bol verejný kľúč nastavený.

5.4	 Import verejného kľúča banky
•	 O verejný kľúč banky požiadajte emailom na adrese eb@unicreditgroup.sk
•	 V aplikácii Kleopatra zvolíme možnosť Súbor -> Importovať a vyberieme práve stiahnutý verejný kľúč banky.
•	 Kleopatra vás vyzve na certifikáciu práve importovaného kľúča -> potvrďte a zvoľte si svoje heslo.

mailto:eb@unicreditgroup.sk
mailto:eb%40unicreditgroup.sk?subject=
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5.5	 Šifrovanie / dešifrovanie sťahovaných súborov bankou
Pre sťahované súbory je možné zvoliť, že budú vždy šifrované pomocou verejného kľúča klienta. Takéto nastavenie je potrebné vopred 
dohodnúť v zmluvnej dokumentácii s vaším bankovým poradcom.

Po stiahnutí súboru je súbor potrebné dešifrovať, inak nie je čitateľný. Súbor je možné dešifrovať iba na počítači, kde je uložený 
súkromný kľúč k technickému užívateľovi.

•	 Pomocou aplikácie Kleopatra: menu File > Decrypt/Verify Files…, vyberte súbor a operáciu Decrypt.

5.6	 Šifrovanie / Podepisovanie nahrávaných súborov
Pre nahrávanie súborov cez BusinessNet Connect je možné voliteľne nastaviť tieto 3 parametre: 

•	 Šifrovanie nahrávaných súborov  
Súbory sú šifrované verejným kľúčom banky pred tým, než sú nahrané pomocou BusinessNet Connectu. Šifrovanie môže mať 
hodnoty Nie / Povinne / Voliteľne (Banka bude prijímať tak šifrované, ako aj nešifrované súbory).

•	 Elektronický podpis nahrávaných súborov  
Súbor platieb sa podpíše súkromným kľúčom vytvoreným v aplikácii Kleopatra. Ďalej sa zašifruje verejným kľúčom banky. Banka 
súbor platieb rozšifruje súkromnou časťou svojho kľúča a overí podpis, ktorým bol súbor na strane klienta podpísaný – čiže verejnú 
časť klientovho kľúča, ktorú odoslal do banky. 
Podpisovanie môže mať hodnoty Nie / Povinne / Voliteľne (Banka bude prijímať tak podpísané, ako aj nepodpísané súbory).

•	 Automatické zpracovanie príkazov  
Pokiaľ je nastavené na hodnotu Áno, potom sú všetky digitálne podpisy právne záväzné a na všetky príkazy v balíčku je pozerané, 
ako by ich autorizoval užívateľ v BusinessNet Professional. Nahraný balíček je automaticky poslaný do podpisovacieho procesu 
a finálne podpísané príkazy sú rovno spracované účtovným systémom banky.  
Pokiaľ je nastavené na Nie, potom nie je nikdy nahraný balíček automaticky poslaný do podpisovacieho procesu (zostane v stave 
„Na podpis“ a je potrebné ho manuálne podpísať v BusinessNet Professional. 
Podmienkou aktivácie automatického spracovania príkazov je použitie certifikátu na overenie prihlasovacích údajov.

Tieto nastavenia musia byť uvedené v zmluvnej dokumentácii k BusinessNet Connect.

5.6.1	 Šifrovanie nahrávaných súborov

Pokiaľ je šifrovanie pre BusinessNet Connect nastavené ako povinné, potom musia byť súbory pred nahraním zašifrované verejným 
kľúčom Banky.

Pre zašifrovanie súboru:
•	 V aplikácii Kleopatra zvoľte menu Súbor > Podpísať/zašifrovať.
•	 Vyberte súbor, ktorý chcete šifrovať, a vykonajte nasledujúce nastavenia:

	• Sign as: pole ponechajte prázdne (súbor má byť iba zašifrovaný).
	• Encrypt for me: pole ponechajte prázdne. 
	• Encrypt for others: tu zvoľte verejný kľúč banky importovaný do programu Kleopatra.
	• Encrypt with password: pole ponechajte prázdne.

•	 Pokračujte voľbou Šifrovať.
•	 Výsledný súbor nahrajte do príslušného adresára Upload (pozri Kapitolu 4).
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5.6.2	 Šifrovanie a podpisovanie nahrávaných súborov

Ak je podpisovanie pre BusinessNet Connect nastavené ako povinné, potom musia byť súbory pred nahraním zašifrované verejným 
kľúčom banky a podpísané jedným z užívateľov, ktorý je držiteľom RSA kľúča (pozri kapitolu 5.2).
Verejný kľúč užívateľa musí byť registrovaný v Banke.

Pre podpísanie súboru užívateľom zvoľte:
•	 V aplikácii Kleopatra zvoľte menu Súbor > Podpísať/zašifrovať … a formulár vyplňte nasledovne:

	• Sign as: vyberte používateľa, ktorému bol nastavený pár kľúčov RSA pre digitálny podpis príkazov.
	• Encrypt for me: pole ponechajte prázdne.
	• Encrypt for others: tu zvoľte verejný kľúč banky importovaný do programu Kleopatra.
	• Encrypt with password: pole ponechajte prázdne.

•	 Pokračujte voľbou Podpísať/Šifrovať.
•	 Ďalej zadajte heslo, ktoré ste nastavili pri vytvorení RSA kľúča.
•	 Výsledný súbor nahrajte do príslušného adresára Upload (pozri kapitolu 4).

Upozornenie: Ak je pre BusinessNet Connect nastavené automatické spracovanie súborov, potom sú po nahratí príkazy obsiahnuté 
v platobnom súbore rovno odoslané do podpisovacieho procesu. Ak sú príkazy podpísané potrebnými podpismi, sú okamžite 
odovzdané na spracovanie.
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